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Welcome to AFH LD 
 
The AFH LD software is used to transmit data from Sauter dynamometer to your 
computer. It enables you to save the measurement data as an XML file and thus to 
import them to any software compatible with XML. Additionally, it allows for a graphic 
presentation of the measurement data and for saving them as a graphic file. 

What's new? 
Version 2.0.0.X enables you to control the measuring station through AFH LD (only 
for FH and FL devices), search for newly connected measuring instruments and de-
fine the emergency trip. Furthermore, the software may be used along with SAU-
TER's LD distance meters. The software allows you to switch between force or path 
measurements. 
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1 System requirements 
 
AFH LD is designed for Microsoft Windows and requires special system software 
and equipment. The software is distributed as a standard installation package. For 
more information on software installation, see “Installation”. 
Equipment:  
– computer compatible with IBM, 
– minimum one serial port (RS-232) or USB-to-serial port converter, 
– 256 MB RAM, 
– 10 MB of available disk space, 
– SAUTER measuring station, LD distance meter and dynamometer. 
 
Operating system:  
Microsoft Windows 2000/XP/Vista/7/8/10 (32 or 64 bits) 
Other requirements:  
NET Framework 2.0 

2 Installation 
 
The AFH LD software is distributed as a standard installation package. The product 
is designed for Microsoft Windows (Windows XP, Windows 7, Windows 8, Windows 
10) and requires special system software and equipment (see “System require-
ments”). 
 
How to install AFH LD? 
 
Start the setup program (“Setup”) on the CD and proceed as per the instructions 
given by the Setup Assistant. In Windows Vista/7/8/10, the user account must have 
administrator authorisation. When the installation program is started, you will see a 
request to select the software installation language. Options: English, German. 
 

 
 
Choose the desired language and press OK.  
Then you will see the Setup Assistant configuration window. 
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Press “Next” to view the dialog box with target folder selection. Here you can 
change the folder where the AFH LD software will be installed. 
 

  
 
In the next window, you can choose the type of installation. 
 
Options: 
Installation of the application and an appropriate list of devices. 
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Device List Installation  only the device list will be installed. 
 

  
 
Press “Next” and choose if you want to create the desktop and/or task bar icon. 
 

  
 
In the next window, you will see the summary of installation options. Press “Install” to 
install the application. 
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Once installed, you can start AFH LD to complete the setup procedure. 

  
Click “Finish” to complete the installation process.  
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3 Equipment installation 
 
Install the software on the computer. 
Connect:  
 the dynamometer by a serial cable, directly to the (FH) measuring station's 

equipment port or by a USB cable directly to the computer, depending on 
the type; 

 the distance meter directly to the computer by a USB cable; 
 the measuring station to the computer by a serial cable. If the COM 1 port 

is unavailable, you can use the RS-232/USB converter. 
 
Switch on all devices. 
 
Start the application. 
 
During start-up, the application will search the computer's serial ports to detect 
SAUTER dynamometers and distance meters. If no distance meter is found, a mes-
sage will be shown in the status bar. 

 
Otherwise, if a distance meter is found, the following message will be shown: 

  
 

4 Main features 
The description below is a summary of important and interesting characteristics of 
AFH LD.   

4.1 Serial Interface window 

 
 
This window shows the information on the interfaces detected. 
It allows you to modify the parameters. However, this is not 
necessary, as the parameters are automatically adjusted to the 
peripherals. Incorrect parameters may affect the software func-
tions. 
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4.2 Measuring Instruments window 
 
View the “Measuring Instruments” window to manage the measur-
ing instruments. It allows you to create or remove measuring in-
struments, to change their parameters, or to control the connection 
with a measuring instrument. If the measuring instrument man-
agement window is not shown, you can view it by clicking 
ViewMeasuring Instruments. 
 
 
 
 

4.3 Control of connection with measuring instrument 
 
 
 
To check the connection with a measuring instrument, view 
the “Check connection” dialog box. You can do it by double-
clicking the equipment icon or by right-clicking the equip-
ment icon and choosing “Check connection” from the con-
text menu. 

4.4 Control of measuring station 
 
To enable a manual control of the measuring sta-
tion using AFH LD, view the dialog box “Control of 
Measuring Station”. The dialog box can also be 
viewed by clicking ViewMeasuring Station in the 
main menu. 
 
 
 
 
 
 

4.5 Measurement series recording 
To record a series of measurements, create a new measurement document by click-
ing FileNew.  
After the application records a measurement series containing over 500,000 measur-
ing points, no new measurement series can be opened. 
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5 List of all features 
 
The following list includes all characteristic features of the AFH LD software. De-
tailed description of all individual features is provided in section “User interface”. 

5.1 Basic features 
- Recording of several series of measurements: force/time and/or force-path  
- Management of serial interfaces 
- Management of measuring instruments 
- Viewing and printing of the recorded measurement data in a single chart 
- Saving the recorded measurement series as an XML 
- Multilingual user interface (see “Installation”) with contextual help 
- Modern user interface, simultaneous work with several charts using tabs — 

see “User interface” 

5.2 Measurement series recording 
- Possibility to record several series of measurements (force-time and/or force-

path) — (measurement series of up to 500,000 measured values must be re-
corded individually) 

- Printing and print preview of displayed measurement data 
- Analogue view of the current value 
- View of the chart including all measurement series with the zoom function 

5.3 Saving/export 
- XML: Click “Save” or “Save As” to save the measurement data as an XML file. 
- EMF: Click “Save Image As” to save the measurement data as an EMF file. 
- PNG: Click “Save Image As” to save the measurement data as a PNG file. 
- BMP: Click “Save Image As” to save the measurement data as a BMP file. 

 
Licence 
This product is distributed as a licence for one user (see “Licence Agreement”). 

6 User interface 
 
The objective of this section is to provide summarised information on the way of using 
and the functionality of the application depending on the menu. 
If you do not find the needed support in this section, try to find it in section “How 
to...?”.  
 
Basic elements of user interface 

- Main menu 
- Tab bar 
- Status bar 
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Other windows and dialog boxes 
- Control of Measuring Station 
- Serial Interfaces 
- Devices 
- Settings 
- Analogue Display 
- Large-Size Display 
- “About the Application...” dialog box 

 
Add-ins 
The way of interpreting different device protocols is managed in separate parts of the 
software (add-ins). An add-in is available for each special type of device. 
Use the “Settings” dialog box to download the current add-ins. 

7 Basic elements of user interface 
 
The picture below presents the basic elements of the user interface in AFH LD. 
 

  
 
Review of user interface elements  

- Main menu 
- Toolbars 
- Tab bar 
- Graphic region 
- Properties window 
- Status bar 

7.1 Main menu 
The main menu consists of the following submenus: 
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- File 
- Measurement Series 
- Image 
- View 
- Help 

7.1.1 File 
The “File” menu includes the following commands: 

- New — creates a new document 
- Open — opens an existing document 
- Close — closes an existing document 
- Save — saves the current document under its file name 
- Save As — saves the current document under a different name 
- Page Settings — allows you to choose a print format 
- Print — prints out the current document 
- Print Preview — allows you to preview the document to be printed 
- Exit — closes the AFH LD application 

7.1.2 New 
New command (“File” menu) 
Use this command to create a new document in AFH LD. Use the command “Open” 
to open an existing document. 
 
Shortcut 

Toolbar:   
Keyboard:  Ctrl+N 
 

7.1.3 Open 
Open command (“File” menu) 
Use this command to open an existing document in a new window. You can open 
several windows at the same time. The “Window List” menu is used to switch be-
tween documents. 

You can open new documents by clicking “New”. 
 
Shortcut:  

Toolbar:   
Keyboard:   Ctrl+O 
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7.1.4 Close 
Close command (“File” menu) 
Use this command to close all windows showing the current document. Before the 
document is closed, AFH LD will recommend saving all changes made in the docu-
ment. If you save the document without saving the changes, you will lose all the 
changes made after the last saving. Before closing a document without a name, AFH 
LD will show a dialog box where you can give a name to the document and then 
save it. 
You may also use the icon “Close” as shown below: 

 

7.1.5 Save 
Save command (“File” menu) 
Use this command to save the current document under its current name. If the 
document is saved for the first time, AFH LD will display the dialog box “Save As”, 
where you can name the document. To change the name or folder of an existing 
document, click “Save As”. 
 

Shortcut 

Toolbar:   
Keyboard:   Ctrl+S 

7.1.6 Save As 
Save As command (“File” menu) 
Use this command to give a name to the current document and then save it. AFH LD 
will show the dialog box “Save As”, which allows you to enter the document name. 
To save the document under its current name, click “Save”. 
“Save As” dialog box 
You can specify the location and name of a document to be saved using the following 
data entry fields: 
– File Name: Enter a new name to save the document under a different name. AFH 

LD will supplement the file name by the extension shown in “File Type”. 
– Drive:  Choose the drive where the file is to be saved. 
– Folder: Choose the folder where the file is to be saved. 
– Network: Use this option to enable connection to your own network. 

7.1.7 Search Measuring Instruments 
Search Measuring Instruments command (“File” menu) 
Use this command to search newly connected measuring instruments and serial in-
terfaces. 



14                                                                           AFH_LD-BA-e-1710 

Shortcut 

Toolbar:   

7.1.8 Page Settings 
Page Settings command (“File” menu) 
This dialog box is used to change the settings of the printer and paper format. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.1.9 Print 
Print command (“File” menu) 
Use this command to print the document. If you click this option, the application will 
show the printer dialog box, where you can select the number of pages, printer and 
its settings. 
 
Shortcut 

Toolbar:   
Keyboard:   Ctrl+P    

7.1.10 Print Preview 
Print Preview command (“File” menu) 
 
Use this dialog box to see what the printed document will look like on the page. 
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7.2 Measurement series 
The Measurement Series menu includes the following commands: 

- Start: starts the recording of measurement data 
- Stop: stops the recording of measurement data 
- Finish: completes the recording of measurement data 
- Manual Dispatch: sends defined device control commands to the measuring 

instrument 
- Time-Controlled Dispatch: sends defined device control commands to the 

measuring instrument at regular intervals 
 
The commands are also available on the “Measurements” toolbar: 

 Force/Time measurements 
 

 Force/Path measurements 
 

 

7.2.1 Image 
The Image menu includes the following commands: 

- Show Tab: shows and hides the tab in the image window 
- Save Image As: saves the image as a file (EMF, PNG, BMP) 
- Copy: copies the graphic region to the Windows clipboard 

7.2.2 View 
The View menu includes the following commands used to manage the serial inter-
faces and measuring instruments, and to change the program settings: 
– Serial Interfaces: shows or hides the window for serial interface management 
– Measuring Instruments: shows or hides the window for serial interface manage-

ment 
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– Settings: opens the window for program settings management 
– Status Bar: shows or hides the status bar 
– Measuring Station: shows or hides the “Measuring Station” dialog box 

7.2.3 Help 
The Help menu includes the following commands: 
– Contents: shows the contents of the help file 
– Index: shows the index of the help file 
– Find: allows you to search specific entries in the help file 
– About the Application...: shows further information about AFH LD 
 

8 Toolbars 
AFH LD provides two different toolbars. One includes the main menu commands, and 
the other one – graphic commands. 

 

8.1 Main menu commands 
- New — creates a new document 
- Open — opens a new document 
- Save — saves the active document under its file name 
- Print — prints the active document 
- Search Measuring Instruments — searches the recently connected measuring 

instruments 
- Help — shows the help file 

8.2 Graphic commands 
- Copy — copies the image to the Windows clipboard  
- Tab — shows or hides the tab in the image window 
- Show All — shows the whole measurement series in the image window 
- Show Previous — restores the previous image size 
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8.3 Window bar 
Use this menu to switch between different windows. 
 
 
 
 
 
 
 
 

 

 
 

8.4 Tab bar 
 
The tab bar is used to switch between the opened documents with measurement se-
ries. 

 
 
It allows you to switch between the visible tabs (screens) or to remove them from the 
window list (close). 
 
You can switch between documents with the mouse or using the keyboard, by click-
ing Ctrl+Tab or Shift+Ctrl+Tab. 
Use Ctrl+F4 to close a tab (screen). You can change the order of tabs by dragging 
them with the mouse. 
Right-clicking a tab will open the context menu, where you can display the current 
measured value in the analogue or enlarged view. 

– Measuring Instrument: shows the current measured value as an indication of the 
analogue measuring instrument 

– Large-Size Display: shows the current measured value in its own window, with 
zoom 

8.5 Graphic view 
In the graphic view, the measurement series is shown as a chart. The appearance 
can be changed using the “Settings” dialog box. It allows you to adjust the back-
ground colour, chart colour, etc. 
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8.6 Status bar 
The status bar is displayed by the bottom edge of the AFH LD window. You can show 
or hide the status bar by clicking “Status Bar” in the “View” menu. 

8.7 Other windows and dialog boxes 
The application includes other windows and dialog boxes, which are not described in 
the previous sections. Here you will find the links to appropriate sections. 

You should pay a particular attention to the dialog box “Settings”. 

8.8 List of windows and dialog boxes 
- “Measuring Station” dialog box 
- Serial Interfaces 
- Measuring Instruments 
- Settings 
- “About the Application...” dialog box 

8.9 Dialog box for controlling the measuring station 
 
This dialog box is used to control the measuring 
station. It is only available if a distance meter is de-
tected during software start-up.  
The dialog box contains three keys used to control 
the motion of the measuring station, one key to reset 
the dynamometer, and an indicator showing the cur-
rent direction of the measuring station. Additionally, 
it displays the measuring station's position and cal-
culated speed. 
 
Hint: 
After you connect the device and start AFH LD, 

close and restart the program or select “Search Measuring Instruments” to detect the 
measuring instruments. 
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8.10 Serial Interfaces 
This window shows all available serial interfaces of your computer. Select the ap-
propriate interface to view or change the settings. This will allow you to adjust the 
corresponding settings in the lower window. 

 

8.11 Measuring Instruments 
This window shows all the measuring instruments cre-
ated. To change the properties of an individual device, 
select the device and adjust its properties. By right-
clicking the window you can add a new measuring in-
strument. 
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8.12 Settings 
 
In the “Settings” dialog box, you can change the application parameters. Some pa-
rameters (e.g. the ones used to change the device properties) are saved automati-
cally, and other (chart appearance) are available additionally from the AFH LD tool-
bar. However, all the most important settings can be found in this dialog box. 
The dialog box is divided into different categories (Image, View, Add-In) depending 
on the contents and parameter importance. This section contains the descriptions of 
each category and parameter. 

8.13 Image 
 
Used to change the background of graphic image, the colour of the measurement 
curve or of the grid. 
Image — switches on/off the edge smoothing function to improve the quality of the 
measurement curve 
Measurement Curve — shows/hides the grid, shows/hides the lines between meas-
urement points, shows the measured values as spot symbols 

 

8.13.1 Display 
Measuring Instrument — adjusts the colour of the limit value, scale and the hand of 
the analogue measuring instruments 
Large-Size Display — used to choose the background colour, type and size of font on 
the large-size display 
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8.13.2 Add-In 
 
Load — downloads the current add-ins to interpret the measuring instruments’ proto-
cols (Internet connection required) 
Delete — deletes the unnecessary add-ins from the hard disk 

 

8.13.3 Analogue Indication 
 
In this window, the current measured value is shown as an analogue measuring in-
strument. You can mark the range of limit values by choosing a different colour in the 
“Settings” dialogue box. 
 

 
Right-click the measurement series to activate the window. 

 

 

8.13.4 Enlarged Indication 
 
In this window, the current measured value is shown in the enlarged form. You can 
change the font type and colour in the “Settings” dialog box. 
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8.14 About the Application... 

  This dialog box shows the logo, version and all additional information about 
AFH LD.  

9 Calibration 
 
Before measuring, you must calibrate the distance meter. To this end, the delivered 
package includes a 100 mm calibration bar used for calibration.  
 

 
 
To perform the calibration, proceed as follows. 
 
In View --> Settings, go to the following table. 
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In “Measuring Instruments”  

 
 
select the appropriate distance meter. The number indicates the length [mm] for 
which the distance meter may be used.  
To start the calibration, move the measuring station to its lowest position. 
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Then press “Apply Value”. 

 
 
Then move the measuring station by 100 mm up. While the measuring station is 
slowly lowered, position the calibration bar in such a way that after being moved by 
100 mm it causes the limit switch to deactivate. (Caution! Risk of crushing) 
Press “Apply Value”. 
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Press “Finish Calibration”. Remove the calibration bar.  

 
 
Press OK. The calibration is complete. 

  
You will see the status on the lower left side. 
The values will be saved and will remain available after the next start-up of the appli-
cation, until the next calibration. We recommend a new calibration after a long period 
of downtime or if any deviations are detected. Now everything is ready for initial 
measurement. 

10 Initial measurement (recurring measurement) 
 
Create a new measurement series document. 

 
 
Choose the measuring instrument to be used (if the device is not displayed, you can 
add it in the “Measuring Instruments” window; see section 8.11). 
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In “Settings” you can set the following parameters. 
 

Measuring Instrument: here you can select the 
measuring instrument from the pull-down menu. 

- Emergency Trip: here you can set the value where 
the measuring station will trip in case of emergency 
(do not set a value that exceeds the maximum load 
of the dynamometer). 

- Change Number Sign: changes the direction in 
which the curve is displayed. 

- Switch at Limit: here you can force a change of 
direction after passing a certain path or after reach-
ing a preset force. 

- Cycles: here you can set the number of cycles. In 
case of high values (> 10,000), the software can 
run more slowly. 

- Device Limits: here you can generally specify 
whether the limit values should be applied. 

- Horizontal Reflection: activates the mirror reflection 
of the measurement curve. 

- Measurement Type: here you can select the 
Force/Path or Force/Time measurements, or 
memory readout. 

- Upper Limit: here you can enter the force or path 
value. 

- Title: here you can name the measurement.  
- Lower Limit: here you can enter the force or path value. 
- Path Reversal: Yes or No. 
- Time Interval: here you can set the cycles in which the program will record the 

measurement data.  

Then continue the measurement by pressing .  
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Press the right arrow key.  

 
Start the measurement by pressing the up or down arrow key. The measuring station 
will start moving and transmitting the data to the software.  
 

 
 
Once the measurement is completed, you can save the results in any location.  
 
To complete the measurement: stop it, save the data, close the program and switch 
off all devices.  
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